Baza podataka

· u poduzećima nastaju velike količine podataka i informacija
· podaci se mogu smjestiti u MS Excelovu radnu tablicu (plošne baze podataka)
· na spremljene podatke postavljaju različiti upiti i složena pretraživanja

def. Baze podatka
i) je sustav koji sadrži određenu količinu organiziranih podataka koji je stvoren za potrebe računalne obrade.
ii) je organizirana i uređena cjelina međusobno povezanih podataka  spremljenih bez nepotrebne redundancije.
redundancija ili zalihost – nepotrebno udvostručavanje ili umnožavanje podataka
· podatci o nekom dokumentu zapisuju se na više mjesta
U bazu ne možemo spremiti osobne stvari , predmete ili ljude, ali možemo spremiti njihova svojstva.
Prema vrsti podataka baze podataka mogu biti:
1. klasične – sadrže samo brojčane i tekstualne podatke
2. multimedijske– sadrže multimedijske podatke (tekst, brojevi, statička i dinamička slika i zvuk.
· Primjeri: MS Encarta, Britannica, Atlas svijeta, Svijet životinja i dr.
· Razvojem Interneta jača uporaba multimedijskih BP – tekstualni se podaci organiziraju i pohranjuju u obliku hiperteksta s linkovima na multimedijalne datoteke.

Ovisno o vrsti i namjeni podataka kao i načinima korištenja  razlikujemo:
1. Formatizirane - Formatizirani podaci imaju utvrđenu strukturu, odnosno shemu kojom je
određeno koji se podaci u nju mogu uvrstiti, koja je njihova pozicija, tip i predviđena dužina, odnosno broj znakova i slično.
2. Neformatizirane - Neformatizirani podaci nemaju utvrđene strukture i najčešće se pojavljuju u
obliku slobodnog teksta.

Bazom podataka upravlja sustav za upravljanje bazom podataka (DBMS – Database Management System; SUBP). 

Glavne funkcije DBMS jesu:
1. Definiranje podataka – možemo odrediti koji podaci će se spremati u bazu, kojeg su tipa i kako su povezani
2. Rukovanje podacima - unošenje, uređivanje, prikazivanje, pretraživanje, sortiranje podataka 
3. Nadzor nad podacima – možemo odrediti prava pristupa podacima  i nadzor ispravnosti podataka 
Postoji čitav niza sustava za upravljanje bazom podataka: Oracle, ZIM, DB2, Informix, MS Access, Clerion; Progres; Clipper itd. 

Entitet
Svijet oko sebe možemo shvatiti kao skup entiteta koji su u međusobnom odnosu i djelovanju. 
Entitet – predmet našeg zanimanja u realnom svijetu. Entitet predstavlja stvaran ili apstraktan objekt ili događaj o kojem se u IS prikupljaju podatci. Entitet je ono o čemu želimo prikupljati i pohranjivati podatke (npr. kuća, student, auto, itd.).
Može biti:
1. Realni objekt:
· osoba (učenik, djelatnik, glumac, prijatelj, glazbenik, stanar, član video kluba itd.)
· predmet (automobil, knjiga, film, pjesma)
2. apstraktni sadržaj (radno mjesto, status studenta)
3. Pojava ili događaj (rođenje, uplata, upis, ispit, test, prometni prekršaj)
4. Odnos (učenik-nastavnik, djelatnik tvrtka)

Entitet možemo izdvojiti iz okoline i opisati ga njegovim svojstvima – atributima.
Svaki entitet može imati više svojstava ili atributa.
Atribut ima svoje ime i vrijednost.

Učenik: ima ove atribute: prezime, ime, datum rođenja, mjesto rođenja, adresa, škola, matični broj, razred, itd.
Knjiga: naziv, autor, god-izd, broj stranica, izdavač, kategorija




Organizacija podataka

Svi su podaci u bazi podataka organizirani po logičkim jedinicama.
Logičke jedince su:
	Polje- najmanja logička jedinica (stupac tablice)- atribut
	Slog – skup polja koji se odnose na isti entitet (redak tablice)
	Datoteka – skup svih slogova koji se odnose na isti entitet
	Baza podataka – skup međusobno povezanih datoteka
Koje su fizičke jedinice podataka? (b,B, Kb, MB, ….
Datoteku možemo promatrati kao logičku  i fizičku strukturu.
· Logička datoteka skup je logički organiziranih podataka kako ih vidi korisnik. 
· Pod fizičku se strukturu ubrajaju sva svojstva vezana uz pohranu i upravljanje datotekom na računalnom sustavu.
	
Postoji nekoliko modela baze podataka:
1. plošni - jedna (dvodimenzionalna) tablica (npr. U Excelu)
2. hijerarhijski – ima oblik stabla, podaci su hijerarhijski ovisni jedan o drugom (nadređeni i podređeni podaci). Ako želimo doći do podređenog podataka moramo znati njegov nadređeni podatak.
3. Mrežni – primjenjuje se kod velikih baza podataka, temelji se na logičkim vezama među podacima, zahtijeva brza i snažna računala i veliko informatičko znanje, postoji hijerarhija podataka ali i više nadređenih podataka
4. relacijski  – zasnovan je na relacijama – logičkim vezama podataka u tablicama.

· danas prevladavaju relacijske BP




Relacijske baze podataka

Struktura relacijskih BP temelji se na nizu samostalnih tablica koje su međusobno logički povezane. Svaka tablica opisuje samostalnu cjelinu.
Operacije (postupci) koji se provode nad tablicama jesu:
a) projekcija – izdvajanje iz tablice samo onih stupaca koji nas trenutno zanimaju
b) selekcija – je izdvajanje iz tablice onih redova (slogova) koji ispunjavaju određeni uvjet
c) Pridruživanje – je povezivanje dviju tablica preko zajedničkog polja

Osnovne karakteristike tablice (relacije) su:
·  ne postoje dva jednaka retka 
·  ne postoje dva jednaka stupca
·  redoslijed redaka nije bitan
·  redoslijed stupaca nije bitan 

Za podatke koji se često ponavljaju  unutar jednog polja definiraju se nove tablice koje se povezuju s podacima u početnoj tablici.
Ponavljanje (dupliciranje ) podataka naziva se redundancija
Ponavljanjem podataka:
· nepotrebno se troši memorijski prostor i 
· ako je potrebno ispraviti podataka onda se to mora napraviti na svakom mjestu u tablici gdje se taj podataka nalazi.

	RB
	Prezime
	Ime
	Zanimanje
	Datum-zaposlenja
	Odjel
	Šef odjela

	1. 
	Androšević
	Marija
	Ekonomist
	12.2.2008
	Prodaja
	Ivona Bedeniković

	2. 
	Kasunić
	Katarina
	Poslovni tajnik
	20.7.2009
	Nabava
	Jelena Tucibat

	3. 
	Lipošćak
	Igor
	Ekonomist
	16.8.2008
	nabava
	Jelena Tucibat

	4. 
	Gojković
	Tena
	Ekonomist
	15.4.209
	marketng
	Igor Lipošćak








Objekti baze podataka
1. Tablica (Table) se sastoji od stupaca koji tvore polja (Fields) i redaka koji tvore slogove (Records). Tablica je polazište za sve ostale oblike prikaza i obrade podataka. Na temelju nje mogu se kreirati različiti objekti koji pomažu u radu. 
2.Obrasci (Forms) - formulari koje kreiramo da bismo lakše unosili i mijenjali podatke u tablici. Na zaslonu će prikazivati se po jedan slog podataka. Za pojedina polja možemo odrediti potrebna ograničenja kako bismo smanjili mogućnost pogrešnog unosa podataka, npr. ako unosimo ocjene da to budu brojevi od 1 do 5.
3.Upiti (Queries) - pomoću njih pronalazimo i prikazujemo podatke koji zadovoljavaju postavljene uvjete, npr. da se prikažu učenici s odličnim uspjehom ili da se prebroji koliko podataka u tablici zadovoljava postavljeni uvjet, npr. koliko je učenika prošlo s 5.
4.Izvještaji (Reports) - služi za kreiranje oblika u kojem će se ispisati podaci iz tablice na pisaču, tj. na način kako odgovara korisniku. 
5. Stranice (Pages) - posebna vrsta web-stranica (Data Access Pages) služe za rad s podacima preko mreže računala (lokalne ili Interneta).
6. Makro naredbe (Macros) - naredbe koje se inače izvode i zadaju pojedinačno pomoću miša ili tipkovnice povezuju se u cjelinu i izvode automatski jedna iza druge.
7. Modul (Modul) - program napisan u Access Basicu. Sadrži naredbe koje se ne mogu izvesti pomoću naredbi ponuđenih u Accessovom izborniku. Koriste se za neke specifične obrade.

Kreiranje tablice 
Design View
Field Name: naziv polja (max. 64 znaka)
 Data Type: vrsta podatka koji će se upisivati u polje
 Description: opis polja, prikazuje se u statusnoj traci
 podešavanje ponašanja polja tijekom upisa i prikazivanja podataka
[image: ]
Data Type  -vrste podataka
	Vrsta
	Primjena i ograničenja

	Text - tekst
	kraći tekst do 255 znakova

	Memo -Dopis
	dulji tekst do 65535 znakova

	Number -Broj
	numerički podaci koji se koriste za matematičke operacije

	Currency  -valuta
	numerički podaci u obliku valute  120,34kn

	Date/Time  - datum i vrijeme
	datum ili vrijeme. Format sukladno Windowsovim postavkama

	AutoNumber - Samonumeriranje
	automatski brojač sloga, osigurava da svaki slog dobije jedinstveni broj
redni brojevi 1,2,3….

	Yes/No    - da/ne
	booleove vrijednosti tipa da/ne ili točno/netočno  (muško/žensko)

	OLE Object  - 
	objekti drugih programa (npr. dokumenti Worda, tablice Excela, zvučne i grafičke datoteke itd.)

	Hyperlink - hoperveza
	URL ili mail adrese  (www.skole.hr )

	Lookup Wizard)  - 
Čarobnjak za traženje
	 Polje koje se popunjava podacima iz druge tablice ili liste zadanih   vrijednosti
	

	Attachement  -privitak 
	 Slike, datoteke dukumenata, grafikoni priloženi zapisima u bazi podataka slično kao privitak u e-mailu
	





	Vrsta
	Raspon
	Byte

	Byte
	0 do 255
	1

	Integer
	-32.768 do 32.767
	2

	Long Integer
	-2.147.483.648  do 2.147.483.647
	4

	Single
	7 decimalnih mjesta
	4

	Double
	15 decimalnih mjesta
	8

	Decimal
	–1028–1 do 1028–1
	12

	Replication ID
	automatski numerički identifikator sloga
	16


General kartica svojstava
	Svojstvo
	Opis

	Veličina Polja (Field Size)
	Određuje dužinu polja

	Oblik (Format)
	Upravlja načinom prikaza i ispisa podataka (npr. prikaz datuma. Npr. kod valutnih polja hoće li se podatak prikazivati u kunama ili eurima.

	Broj decimalnih mjesta (Decimal Places)
	Prikaz broja decimalnih mjesta

	Ulazna maska (Input Mask)
	Zadavanje maske za unos podataka- , npr. kod telefonskog broja
(___) ___-____

	Naziv (Caption)
	Zadavanje naziva polja koji će biti prikazivan u formama i izvještajima. Određujemo naziv koji se prikazuje kad god je tablica aktivna, neovisno od stvarnog naziva polja. Npr. ako polje ima kratki i nerazumljiv naziv Šifr_pro, ovdje možemo odrediti naziv: Šifra proizvoda.

	Zadana vrijednost
 (Default Value)
	Podrazumijevana (zadana) vrijednost polja. Vrijednost koja će se automatski upisati u polje (ako se ne upiše ništa drugo).

	Pravilo provjere valjanosti (Validation Rule)
	Uvjet koji moraju zadovoljavati podaci uneseni u polje (na pr. BETWEEN 1 AND 50)

	Tekst provjere valjanosti (Validation Text)
	Poruka koja će biti prikazana ako podaci ne zadovoljavaju uvjet (npr."NEISPRAVNO - Dozvoljene vrijednosti su između 1 i 50!")

	Potrebno (Required)
	"yes" ako se zahtijeva unos u polje (ne dozvoljava se Null vrijednost). Određuje mora li polje obvezno sadržavati neku vrijednost

	Dopusti nultu duljinu (Allow Zero Length)
	određujemo smije li tekstualno polje biti prazno

	Indeksirano  (Indexed) 
	Vrši li se po tom polju razvrstavanje podataka u tablici.
Odaberemo li za neko polje indeksiranje, moramo se odlučiti želimo li
[bookmark: _GoBack]dopustiti upis istih podataka u tom polju (Yes (Duplicates OK)) ili ne
dopustiti upis istih podataka u tom polju (Yes (No Duplicates))



[bookmark: Indeksiranje]
Indeksiranje baze podataka

Indeksi su nevidljivi brojevi koji se dodjeljuju tekstualnim poljima radi bržeg pretraživanja i sortiranja podataka. Računalo brže pretražuje brojeve nego tekst.
Mogućnosti izbora:
· Yes (Duplicates OK) – polje će biti indeksirano i bit će dozvoljen upis istih vrijednosti u više slogova (prezime, ime , adresa, ime majke,…)
· Yes (No Duplicates - polje će biti indeksirano i neće  bit dozvoljen upis istih vrijednosti u više slogova (u svaki slog se upisuje jedinstvena vrijednost ).
· NO – polje neće biti indeksirano.

[bookmark: Obrasci]Obrasci ili Forme
Objekt baze podataka koji se koristi za unos podataka, prikaz ili mijenjanje podataka u bazi podataka.  Postoje dva načina kreiranja obrazaca:
· Create form by using a wizard  - kreiranje obrasca uz pomoć čarobnjaka
· Create form in design view – kreiranje obrasca u dizajnerskom prikazu – treba ručno sastavljati kontrole i svojstva za njih. 
1. Create form by using a wizard   provodi se u više koraka:
1. odabir tablice ili upita i polja koji će se pokazati na obrascu
2. odabir izgleda obrasca 
a.  Columnar
b. Tabular
c. Datasheet
d. Justified
e. PivotTable
f. PivotChart
3. Odabir grafičkog izgleda obrasca (stila)
4. davanje imena obrascu
Svakom obrascu možemo dodati H/F, zapovjedni gumb (Command Button), mijenjati boju pozadine, boju fonta veličinu itd. To se radi u dizajnerskom prikazu obrasca (Design View)
Obrasci se sastoje od tri dijela:
1. Form Header – služe na obrascu za stavljanje elemenata koji će prikazivati logo firme, tekući datum i slične informacija
2. Details – prikazuju se podaci iz sloga
3. Form Footer

2. Create form in design view
U Prozoru Properties u Record Source upisati tablicu za koju se pravi obrazac.
Dodavanje i brisanje objekata na obrascu
· Label – naljepnica služi kao statični natpis i ne mijenja s  prelaskom sa sloga na slog
· Text Box – tekstualni okvir koji prikazuje podatke iz tablice i sadržaj mu se mijenja prelaskom sa sloga na slog
· Zapovijedni gumb (Command Button) -  gumb kojem se dodjeljuje veći broj akcija (30 gotovih akcija raspoređenih u šest kategorija) Treba na Tool Box uključiti čarobnjaka za izradu objekata. Klikom na gumb akcija će se izvršiti.
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Projektiranje baze podataka

Projektiranje baze podataka obavlja se na papiru, neovisno o računalu. Što je baza podataka bolje planirana, manje su mogućnosti pogrešaka i komplikacija u kasnijem radu. Kod projektiranja baze podataka treba:

1. Odrediti namjenu baze podataka, tj. objekte koje će sadržavati, veze među njima i tko će ih i u koju svrhu rabiti.

2. Odlučiti o tablicama, tj. koje će se tablice kreirati unutar baze podataka.

3. Odrediti polja pojedine tablice. Polja koja bi sadržavala izvedene (izračunate) podatke nije preporučljivo stavljati u tablicu, npr. Vrijednost robe ili prosječnu ocjenu. U ovom je koraku potrebno odrediti i tip podataka: tekst i koje duljine, broj (cjelobrojni, decimalni, valutni), datum ili neku drugi tip podataka.

4. Odrediti indekse i primarni ključ. 

5. Određivanje veza među tablicama. Podatke koji su smješteni u više tablica potrebno je povezati kako bi program mogao pronalaziti međusobno ovisne podatke. 


Ponavljanje gradiva za test
1. Pokretanje Ma Accessa
2. Što je baza podataka?
3. Nabrojite objekte baze podataka?
4. Što sadrži Placesbar?
5. Tablicu možemo kreirati na tri načina, koja?
6. Navedite tipove polja podataka?
7. Koja svojstva polja sadrži donji dio prozora (Field Properties)?
8. Razlika između modernih i klasičnim baza podataka
9. Što je to DBMS, od kojih riječi je nastao i koje su mu funkcije?
10. Nabrojite nekoliko sustava za upravljanje bazom podataka?
11. Entitet?
12. Što može biti entitet?
13. Odnos entitet, atribut, i vrijednost atributa?
14. Što je primarni ključ?
15. Logičke i fizičke jedinice podataka?
16. Modeli baza podataka?
17. Što su polja podataka, a što zapisi ili slogovi?
18. Vrste veza između tablica i po dva primjera za svaki tip?
19. Što predstavlja UDK, a što ISBN?
20. Indeksiranje podataka?

Stvaranje i uređivanje veza između tablica
· neke od tablica imaju iste podatke
· podaci iz jedne tablice mogu se povezati s podacima iz druge tablice
· u prvoj tablici polje koje povezujemo je primarni ključ,  a u drugoj je to polje vanjski (strani) ključ
· polja na osnovi kojih se vrši povezivanje moraju biti istog tipa
[image: ]Tools >Relationships ili gumb iz alatne trake [image: ]








Uspostavljanje veza među tablicama vrši se na osnovu ključa tako da sadržaj u polju primarnog ključa jedne tablice mora odgovarati sadržaju polja stranog ključa druge tablice.  Metoda kojom se to osigurava naziva se referencijalni integritet. Uključivanje referencijalnog integriteta osigurava da se:
1. ne može mijenjati vrijednost primarnog ključa ako postoji povezani slog u nekoj drugoj tablici
2. ne može izbrisati slog u tablici primarnog ključa ako postoji povezani slog u nekoj drugoj tablici
3. ne može unijeti vrijednost vanjskog ključa prije nogo se unese ista vrijednost kao primarni ključ u povezanoj tablici
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Uključivanje opcije:
Cascade Update Related Fields – osigurava da nakon svake promjene primarnog ključa se automatski mijenja i vanjski ključ.
Cascade Delete Related Records – kaskadno brisanje povezanih slogova – osigurava da se nakon svakog brisanja sloga u tablici jedan automatski brišu svi vezani slogovi u tablici više.
Vezu između tablica možemo mijenjati dvostrukim klikom na crtu ili je možemo brisati.
Kreiranje upita
Upit je zahtjev koji korisnik postavlja programu kako bi se izvela neka operacija s podacima. Upit automatski ažurira(osvježava) tablicu s podacima (vrijedi i obratno).
S upitima možemo:
· Odabirati polja
· Odabirati zapise koji zadovoljavaju uvjete
· Postavljati pitanja u vezi podataka koji su spremljeni u više tablica
· Kreirati obrasce, izvješća i grafove 
U Accessu postoje dvije vrste upita:
1. Upiti izdvajanja – služe za pronalaženje i izdvajanje informacija iz jedne ili više tablica
	Select Query – 
	Crosstab Query – 
2. Akcijski upiti – koriste se za brisanje i obnavljanje slogova 

Upit se kreira na dva načina:
1. Create Query by using Wizard  - kada iz jedne ili  više tablica želimo izdvojiti niz polja
2. Create Query in Design View – u ovakvom načinu izrade upita moguće je filtriranje i sortiranje podataka

Osim matematičkih operatora u upitima se koriste i logički operatori. Oni služe za povezivanja složenih uvjeta.
(Jednostavan uvjet) logički operator (jednostavan uvjet)
Tri su osnovna logička operatora:
· AND – složeni uvjet je istinit samo ako su obadva jednostavna uvjeta istinita
· OR - složeni uvjet je istinit  ako je barem jedan od jednostavnih uvjeta istinit
· NOT – istinu pretvara u laž i obrnuto
· oni rade s logičkim vrijednostima True i Fakse (točno ili netočno ili istina i laž).



Vježba:
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1. U tablici Liječnici oblikovati telefon tako da se unosi u obliku 047123456, a da se prikazuje kao (047)333-678  (Input Mask – sastoji se od niza znakova koji predstavljaju čuvare mjesta za stvarne podatke (999)000-0009)

2. Za polje prezime i polje ime napravite ulaznu masku (Input Mask) kojim će se upisano prezime i ime ispisati tako da se prvo slovo ispisuje veliko (>L<???????????????)
3. U tablici Posjet oblikovati datum tako da se automatski upisuje tekući datum (današnji datum). Default Value Date$()
4. U tablici liječnici oblikovati prezime tako da se ispisuje velikim slovima (Format > , a u slučaju da se treba prikazivati malim slovima <) 
5. U tablici Posjet oblikovati datum_kontrole da se prikazuje u obliku  27. ožujak 2009. 
	<> 0
	Entry must be a nonzero value.

	> 1000 Or Is Null
	Entry must be blank or greater than 1000.

	Like "A????"
	Entry must be 5 characters and begin with the letter "A".

	>= #1/1/96# And <#1/1/97#
	Entry must be a date in 1996.


6.  

Ponavljanje -  upiti
def. upita
vrste upita
kreiranje upita
QBE – Query by Example Area 
· Field
· Table
· Sort
· Show
· Criteria
· or

Uvjet
- nije obavezno postaviti uvjet pretraživanja
· ako se ne postavi prikazuju se svi podaci iz tablice
· ako se postavi – izdvajaju se samo oni zapisi koji odgovaraju postavljenim uvjetima
· Uvjet može biti:
1. jednostavan – koji se postavlja na samo jedno polje i sadrži samo jedan operator
Opći oblik   Naziv_polja operator  zadana vrijednost

2. složeni uvjet – je onaj koji se sastoji od više jednostavnih uvjeta. 
Opći oblik :   jednostavni uvjet operator jednostavni uvjet
Operatori koji se upotrebljavaju u složenom uvjetu jesu AND i OR.
	- ako su jednostavni uvjeti povezani operatorom AND bit će prikazani oni slogovi koji zadovoljavaju oba uvjeta.
	- ako su jednostavni uvjeti povezani operatorom OR bit će prikazani oni slogovi koji zadovoljavaju barem jedan uvjet.
Na polja se mogu postaviti i slijedeći operatori:
· Is Null svi slogovi kojima vrijednost nije unesena
· Is Not Null svi kojima je vrijednost unešena

Izračuni u upitima
· za izračunavanje u upitu koriste se izračunata polja, takvo polje je virtualno, tj. postoji sve dok upit ne zatvorimo
· Izračunato polje ime slijedeći izgled:
naziv:izraz
- naziv je proizvoljan npr. CijenaPDV, Starost_djelatnika, God_staza
· izraz je bilo koja formula koju odredite, npr: Tekuca_god – God_Rodjenja, Cijena*1,22
· između naziva i izraza stavlja se dvotočka
Kalkulacije u upitu
· Kalkulacije ili totali su skupna pretraživanja ili izračunavanja u MS accessu
· Na podatke u polju moguće je primijeniti i različite funkcije
· Vrste kalkulacija – str. 82.
· Redak u kojem možemo odabrati navedene funkcije dodajemo u upit pomoću gumba  ili  View> Totals

· Popis funkcija nudi još tri mogućnosti:
· Group By – odabirom ove opcije ne izvršava se ni jedna funkcija nad odabranim poljem, vrijednosti polja upotrebljavaju se za naslove stupaca u odgovoru na upit
· Expression – upotrebljava se kada istovremeno primjenjujemo dvije ili više funkcija
· Where – polja u kojima postavimo ovu opciju služe za postavljanje uvjeta i ne prikazuju se u tablici i na njima se ne primjenjuje nikakva funkcija

· u jednom polju smijemo postaviti ili funkciju ili uvjet, ali ne obje. Ako treba izvršiti funkciju samo nad onim slogovima koji zadovoljavaju postavljeni uvjet, isto polje postavljamo dvaput u upit. Na jedno postavljamo funkciju, a u drugom uvjet (u tom polju u retku Total biramo Where, i u redu Show nema kvačice).
· Nad brojčanim poljima osim prebrojavanja mogu se izvršiti i različiti izračuni
Upit Crosstab Query
· kreiramo kada želimo vidjeti kako su raspoređeni podaci iz dvaju polja (rezultat je nova tablica)
· Upit kreiramo naredbom Query > Crosstab Query
· U taj upit uvijek stavljamo tri polja. U prvi i drugi stupac biramo polja čiji će nazivi stajati u zaglavlju redaka i/ili stupaca. U treći stupac biramo bilo koje polje iz tablice
· U retku Total za prvo i drugo polje ostaje Group By, za za treće biramo Count
· U retku Crosstab za prva dva polja biramo Row Heading ili Column Heading , a za treće Value.
· Rezultat izvođenja jest tablica koja sadrži brojeve dobivene prebrojavanjem podataka u polaznim tablicama

Izvještaji ( Report)
je dokument koji nam prikazuje tražene podatke iz tablica. Izvještaji su objekti baze podataka za formatiranje, izračun i ispis (prikaz) izabranih podataka. 
· 
· Svrha: ispisivanje podataka iz baze na papir.
Prednosti izvještaja u odnosu na druge načine ispisivanja podataka su:
- mogućnost izračunavanja ukupnih ili djelomičnih zbirnih vrijednosti većih skupova podataka i njihove usporedbe
 - mogućnost grupiranja podataka te odvojeni prikaz pojedinih grupa 
- mogućnost izvođenja raznih složenih izračuna unutar pojedinih grupa podataka ili između grupa
- mogućnost umetanja teksta, slika ili grafikona u izvještaj.

·  Podaci za izvještaj mogu se uzeti:
· direktno iz tablice ili 
· iz prethodno kreiranog upita.
· način izrade identičan je izradi obrasca, jedino što kod izvještaja treba paziti na dimenzije papira na koji se ispisuju podaci (A4 – 210x297), 
· za razliku od obrazaca koji su namijenjeni pregledu, mijenjanju, brisanju i upisivanju podataka izvještaji isključivo služe za ispisivanje podataka na papir. 

Dva su načina izrade: 
1. Create report in design view 
2. Create report by using wizard 
Koraci izrade izvještaja pomoću čarobnjaka:
· biramo tablicu ili upit pomoću kojih ćemo doći do potrebnih podataka (biramo potrebna polja)
· odabiremo polje po kojem želimo grupirati podatke
· određujemo način sortiranja (ascending ili Descending)
· Oblik ispisa i orijentaciju papira
· određivanje stila izvještaja
· određivanje naslova izvještaja

· Želimo li mijenjati neke postavke izvještaja to radimo u pogledu Design View.
· Dijelovi  izvještaja:
· Zaglavlje izvještaja (Report header) sekcija koja se pojavljuje na izvještaju samo jednom,na prvoj stranici
· Zaglavlje stranice (Page Header) – pojavljuje se na svakoj stranici kao i u MS Wordu
· Sekcija detalja (Detail) – je najvažniji dio izvještaja jer prikazuje podatke iz tablice i pojavljuje se onoliko puta koliko ima slogova
· Podnožje stranice (Page Footer) - pojavljuje se na svakoj stranici kao i u MS Wordu
· Podnožje izvještaja (Report Footer) - sekcija koja se pojavljuje na izvještaju samo jednom, na zadnjoj  stranici izvještaja
Kreiranje izvještaja u dizajnerskom prikazu:
· Najprije se izvještaju dodjeljuje izvor.
·  Odabirom Edit>Select report označava se cijeli izvještaj.
·  Aktiviranjem dodatnog ekrana Properties izvještaju se dodjeljuje izvor 
· u grupi All u polju Record source odabire se izvor
· izvor za izradu može biti tablica ili upit 

Ponavljanje gradiva

1. Pokretanje Ma Accessa
2. Što je baza podataka?
3. Nabrojite objekte baze podataka?
4. Što sadrži Placesbar?
5. Tablicu možemo kreirati na tri načina, koja?
6. Navedite tipove polja podataka i opišite ih?
7. Koja svojstva polja sadrži donji dio prozora (Field Properties)?
8. Razlika između modernih i klasičnim baza podataka
9. Što je to DBMS, od kojih riječi je nastao i koje su mu funkcije?
10. Nabrojite nekoliko sustava za upravljanje bazom podataka?
11. Entitet?
12. Što može biti entitet?
13. Odnos entitet, atribut, i vrijednost atributa?
14. Što je primarni ključ?
15. Logičke i fizičke jedinice podataka?
16. Modeli baza podataka?
17. Što su polja podataka, a što zapisi ili slogovi?
18. Vrste veza između tablica i po dva primjera za svaki tip?
19. Što predstavlja UDK, a što ISBN?
20. Indeksiranje podataka?
21. Koji su dijelovi obrazaca, a koji izvještaja?
22. Koji objekt baze podataka služi za izradu obrazaca, a koji za izradu izvještaja?
23. Što su kalkulacije i koje su vrste kalkulacija?
24. Kada se koristi upit Crosstab Query, koliko polja služi za izradu tog upita, a gdje se koje koristi?
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